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Notice

1.

12.

13.
14.

Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use of
these circuits, software, or information.
Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, or
other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.
No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics or
others.
You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.
You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for
each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space system;
undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics disclaims
any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product that is
inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.
No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but not
limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH RESPECT
TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO THE IMPLIED
WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.
When using Renesas Electronics products, refer to the latest product information (data sheets, user’'s manuals, application notes, “General Notes for
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such
specified ranges.
Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics products
are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily injury,
injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as safety
design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for aging
degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are
responsible for evaluating the safety of the final products or systems manufactured by you.

. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas

Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is

prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.
Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled

subsidiaries.

(Note2) “Renesas Electronics product(s)’ means any product developed or manufactured by or for Renesas Electronics.

(Rev.5.0-1 October 2020)

Corporate Headquarters Contact information
TOYOSU FORESIA, 3-2-24 Toyosu, For further information on a product, technology, the most up-to-date
Koto-ku, Tokyo 135-0061, Japan version of a document, or your nearest sales office, please visit:

www.renesas.com

www.renesas.com/contact/.

Trademarks

Renesas and the Renesas logo are trademarks of Renesas
Electronics Corporation. All trademarks and registered trademarks
are the property of their respective owners.


https://www.renesas.com/
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and measurement
tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor devices must not be
touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.

2. Processing at power-on
The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins in
a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the level
at which resetting is specified.

3. Input of signal during power-off state
Do not input signals or an 1/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0O
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal elements.
Follow the guideline for input signal during power-off state as described in your product documentation.

4. Handling of unused pins
Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are generally
in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of the LSI, an
associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal become possible.

5. Clock signals
After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal produced
with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.

6. \Voltage application waveform at input pin
Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VL (Max.)
and Vi (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the input level
is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vi4 (Min.).

7. Prohibition of access to reserved addresses
Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these
addresses as the correct operation of the LS| is not guaranteed.

8. Differences between products
Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms of
internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Disclaimer

By using this Renesas Starter Kit (RSK), the user accepts the following terms:

The RSK is not guaranteed to be error free, and the entire risk as to the results and performance of the RSK is
assumed by the User. The RSK is provided by Renesas on an “as is” basis without warranty of any kind whether
express or implied, including but not limited to the implied warranties of satisfactory quality, fitness for a particular
purpose, title and non-infringement of intellectual property rights with regard to the RSK. Renesas expressly
disclaims all such warranties. Renesas or its affiliates shall in no event be liable for any loss of profit, loss of data,
loss of contract, loss of business, damage to reputation or goodwill, any economic loss, any reprogramming or recall
costs (whether the foregoing losses are direct or indirect) nor shall Renesas or its affiliates be liable for any other
direct or indirect special, incidental or consequential damages arising out of or in relation to the use of this RSK, even
if Renesas or its affiliates have been advised of the possibility of such damages.

Precautions

The following precautions should be observed when operating any RSK product:

This Renesas Starter Kit is only intended for use in a laboratory environment under ambient temperature and humidity
conditions. A safe separation distance should be used between this and any sensitive equipment. Its use outside the
laboratory, classroom, study area or similar such area invalidates conformity with the protection requirements of the
Electromagnetic Compatibility Directive and could lead to prosecution.

The product generates, uses, and can radiate radio frequency energy and may cause harmful interference to radio
communications. However, there is no guarantee that interference will not occur in a particular installation. If this
equipment causes harmful interference to radio or television reception, which can be determined by turning the
equipment off or on, you are encouraged to try to correct the interference by one or more of the following measures;

e ensure attached cables do not lie across the equipment

¢ reorient the receiving antenna

e increase the distance between the equipment and the receiver

e connect the equipment into an outlet on a circuit different from that which the receiver is connected
e power down the equipment when not in use

e consult the dealer or an experienced radio/TV technician for help NOTE: It is recommended that wherever
possible shielded interface cables are used.

The product is potentially susceptible to certain EMC phenomena. To mitigate against them it is recommended that the
following measures be undertaken;

e The user is advised that mobile phones should not be used within 10m of the product when in use.
e The user is advised to take ESD precautions when handling the equipment.

The Renesas Starter Kit does not represent an ideal reference design for an end product and does not fulfil the
regulatory standards for an end product.




How to Use This Manual

1. Purpose and Target Readers

This manual is designed to provide the user with an understanding of how to use the e? studio IDE to develop
and debug software for the RSK platform. It is intended for users designing sample code on the RSK platform,
using the many different incorporated peripheral devices.

The manual comprises of step-by-step instructions to load and debug a project in e? studio, but does not
intend to be a complete guide to software development on the RSK platform. Further details regarding
operating the RX140 microcontroller may be found in ‘RX140 Group User’s Manual: Hardware’ and within the
provided sample code. The setup procedure for the RSK Web installer is described in the Quick Start Guide.

Particular attention should be paid to the precautionary notes when using the manual. These notes occur
within the body of the text, at the end of each section, and in the Usage Notes section.

In this manual, the display may differ slightly from screen shots. There is no problem in reading this manual.

The revision history summarizes the locations of revisions and additions. It does not list all revisions. Refer to
the text of the manual for details.

The following documents apply to the RX140 Group. Make sure to refer to the latest versions of these
documents. The newest versions of the documents listed may be obtained from the Renesas Electronics Web
site.

Document Type Description Document Title Document No.
User’s Manual Describes the technical details of the RSK Renesas Starter Kit for R20UT5026EG
hardware. RX140 User’s Manual
Tutorial Manual Provides a guide to setting up RSK environment, Renesas Starter Kit for R20UT5030EG
running sample code and debugging programs. RX140 Tutorial Manual
Quick Start Guide Provides simple instructions to setup the RSK and Renesas Starter Kit for R20UT5031EG

run the first sample. RX140 Quick Start Guide
Smart Configurator Provides a guide to code generation and importing Renesas Starter Kit for R20UT5032EG
Tutorial into the e studio IDE. RX140 Smart Configurator
Tutorial Manual
Schematics Full detail circuit schematics of the RSK. Renesas Starter Kit for R20UT5025EG
RX140 Schematics
Hardware Manual Provides technical details of the RX140 RX140 Group User’s RO1UH0905EJ
microcontroller. Manual: Hardware




2. List of Abbreviations and Acronyms

Abbreviation Full Form
ADC Analog-to-Digital Converter
API Application Programming Interface
bps bits per second
CMT Compare Match Timer
COM COMmunications port referring to PC serial port
CPU Central Processing Unit
E1/E2 Lite Renesas On-chip Debugging Emulator
GUI Graphical User Interface
IDE Integrated Development Environment
IRQ Interrupt Request
LCD Liquid Crystal Display
LED Light Emitting Diode
LSB Least Significant Bit
LVD Low Voltage Detect
MCU Micro-controller Unit
MSB Most Significant Bit
PC Personal Computer
PLL Phase-locked Loop
Pmod™ Thig is a Digilent Pmod™ ngpatible connector. Pmod™ is registered to Digilent Inc.
Digilent-Pmod_Interface Specification
PSU Power Supply Unit
RAM Random Access Memory
ROM Read Only Memory
RSK Renesas Starter Kit
RTC Real Time Clock
SCI Serial Communications Interface
SPI Serial Peripheral Interface
TFT Thin Film Transistor
UART Universal Asynchronous Receiver/Transmitter
USB Universal Serial Bus
WDT Watchdog Timer

All trademarks and registered trademarks are the property of their respective owners.


https://reference.digilentinc.com/reference/pmod/specification?redirect=1
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LENESAS

1. Overview

1.1 Purpose

This RSK is an evaluation tool for Renesas microcontrollers. This manual describes how to get the RSK

tutorial started, and basic debugging operations.

1.2 Features

This RSK provides an evaluation of the following features:
« Renesas microcontroller programming

« User code debugging
« User circuitry such as switches, LEDs and a potentiometer
Through the provided set of sample applications.

The RSK board contains all the circuitry required for microcontroller operation.

R20UT5030EG0100 Rev.1.00
Jan.17.2022 RENESAS
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Renesas Starter Kit for RX140 2. Introduction

2. Introduction

This manual is designed to answer, in tutorial form, the most common questions asked about using a Renesas
Starter Kit (RSK). The tutorials help explain the following:

e How do | compile, link, download and run a simple program on the RSK?
e How do | build an embedded application?
e How do | use Renesas tools?

Files referred to in this manual are installed using the project generator as you work through the tutorials. The
tutorial examples in this manual assume that installation procedures described in the RSK Quick Start Guide
have been completed. Please refer to the Quick Start Guide for details of preparing the configuration.

Due to the project generator, it is possible that line numbers for source code illustrated in this document do not
match exactly with that in the actual source files. It is also possible that the source address of instructions
illustrated in this manual differ from those in user code compiled from the same source. These differences are
minor, and do not affect the functionality of the sample code nor the validity of this manual.

These tutorials are designed to show you how to use the RSK and are not intended as a comprehensive introduction
to e? studio, the compiler toolchains or the E2 emulator Lite. Please refer to the relevant user manuals for more in-
depth information.

21 Smart Configurator Plugin

The Smart Configurator plugin for the RX140 has been used to generate the sample code discussed in this
document. Smart Configurator for e? studio is a plugin tool for generating template ‘C’ source code and
project settings for the RX140. When using Smart Configurator, it supports the user with a visual way of
configuring the target device, clocks, software components, hardware resources and interrupts for the project;
thereby bypassing the need, in most cases, to refer to sections of the Hardware Manual.

Once the user has configured the project, the ‘Smart Configurator’ function is used to generate three code
modules for each specific MCU feature selected. These code modules are name ‘Config_xxx.h’,
‘Config_xxx.c’, and ‘Config_xxx_user.c’, where ‘xxx’ is an acronym for the relevant MCU feature, for example
‘CMT’. Within these code modules, the user is then free to add custom code to meet their specific
requirement. However, these files require custom code to be added between the following comment
delimiters:

/* Start user code for adding. Do not edit comment generated here */
/* End user code. Do not edit comment generated here */

Smart Configurator will locate these comment delimiters, and preserve any custom code inside the delimiters
on subsequent code generation operations. This is useful if, after adding custom code, the user needs to re-
visit Smart Configurator to change any MCU operating parameters.

Note: If code is added outside the above user code area, it will be lost if code generation is executed again
with Smart Configurator.

In this RSK sample project, only some functions are used.
For other useful features, refer to the https://www.renesas.com/smart-configurator.

R20UT5030EG0100 Rev.1.00 S
Jan.17.2022 RENESAS
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Renesas Starter Kit for RX140 3. Tutorial Project Workspace

3. Tutorial Project Workspace

3.1 Introduction

e? studio is an open source integrated development tool that allows the user to write, compile, program and
debug a software product on many of the Renesas microcontrollers.

3.2 Connecting the Debugger

The Quick Start Guide provided with the Renesas Starter Kit board gives detailed instructions on how to
connect the E2 Lite to the host computer. The following assumes that the steps in the Quick Start Guide have
been followed and the E2 Lite drivers have been installed.

e Fit the PMOD LCD display to the board. Ensure all the pins of the connector are correctly inserted in the
socket.

e Connect the E2 Lite Debugger to a free USB port on your computer.

e Connect the E2 Lite Debugger to the target hardware ensuring that it is plugged into the connector
marked ‘E2 Lite’.

3.3 Starting e? studio and Importing Sample Code

To use the program, start e2studio:

Windows™ 8.1: From Apps View @ click ‘Renesas Electronics e2studio > e2 studio icon

Windows™ 10: Start Menu > All Apps > Renesas Electronics RSKRX140 > e2 studio
Windows™ 11: Start Menu > All Apps > e2 studio

e Start e? studio by selecting it from the e
Windows™ Start Menu. The first dlalog box Select a directory as workspace
to appear W||| be the Workspace Launcher e studio uses the workspace directory to store its preferences and development artifacts.

e Click ‘Browse’ and select a suitable location
to store your workspace, using the ‘Make
New Folder’ option as necessary. Click

‘ )
Lau nCh . [ Use this as the default and do not ask again

» Recent Workspaces

Workspace: | C:¥Workspace ~ Browse.

e The e? studio Welcome splash screen will
appear. Click the ‘Workbench’ arrow button
on the far right (circled in the screenshot
opposite).
R20UT5030EG0100 Rev.1.00 RENESAS Page 10 of 23
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Renesas Starter Kit for RX140

3. Tutorial Project Workspace

¢ Once the environment has initialized, select
‘Import project...’ from the ‘Project Explorer’
window.

i Project Explarer = <}==1} '1? E = B8

There are no projects in your workspace.
To add a project:

@ Create a new Makefile project in a
directory containing existing code

[ Createa new C or C++ project

¥ Create a project...
I'.\-,_., mport projects... I

e The Import dialog box will be shown.
Expand the ‘General’ folder icon, and select
‘Existing Projects into Workspace’, then
click ‘Next'.

ﬁ Import m} X ‘
Select P
(=]
Create new projects from an archive file or directory.

Select an import wizard:
1""1:9 filter text
v General ~
B Archive File
1 Existing Projects into Workspace
4 File System
[ Preferences
5 Projects from Folder or Archive
1= Rename & Import Existing C/C++ Project into Workspace
T Renesas CCRX project conversion to Renesas GCC RX
¢ Renesas C5+ Project for CATBKOR/CATEKO
¥ Renesas CS+ Project for CC-RX and CC-RL
F Renesas GitHub FreeRTOS (with loT libraries) Project
& Sample Projects on Renesas Website
& C/C++
& Code Generator
= Install w

2 Back Next > Finish Cancel

e The Import dialog box will allow you to
specify a project to import. Click the
‘Browse’ button and locate the following
directory:

C:\Renesas\Workspace\RSK\RSKRX140

e Ensure that the ‘Copy projects into
workspace’ option is ticked, and then click
‘Finish’.

& import m] b4 ‘

Import Projects —

Select a directory to search for existing Eclipse projects.

(@ Select root directory: | C:¥Workspace¥RSK ~ Browse...
(O Select archive file: T
Projects:

[~ Application (C:¥Workspace¥RSK¥Application) Select All

[ Async_Serial (C:¥Workspace¥RSK¥Async_Serial)

[~] Low_Power_Mode (C:¥Waorkspace¥RSK¥Low_Power_Mode)
[] RTC (C:¥Workspace¥RSK¥RTC) Refesh
[] System_BootLoader_Application (C:¥Workspace¥RSK¥System_BootLoader_Application)

[ System_BootLoader (C:¥Workspace¥RSK¥System_BootLoader)

[+ System_Input_Capture (C:¥Workspace¥RSK¥System_Input_Capture)

[ Timer_PWM (C:¥Workspace¥RSK¥Timer_PWM)

[+ Touch (C:¥Workspace¥RSK¥Touch)

[ Tutorial (C¥Workspace¥RSK¥Tutorial)

Deselect All

Options

[[] search for nested projects

Copy projects into workspace

[ Close newly imported projects upon completion
[JHide projects that already exist in the workspace

Working sets
[ Add project to working sets MNew...
elect

e Click on Tutorial from the list of projects in
the ‘Project Explorer’ on the left-hand side.

=5 Timer PWM
5 Touch
% Tutonial

R20UT5030EG0100 Rev.1.00
Jan.17.2022
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Renesas Starter Kit for RX140 3. Tutorial Project Workspace

34 Build Configurations and Debug Sessions

3.41 Build Configuration
The e? studio workspace will be created with two build configurations: ‘HardwareDebug’ and ‘Release’.

Release

This Build Mode has optimisation turned on, and provides little debug information. The C code execution may
appear to be out of order, due to the way the compiler optimises the code. This build configuration is intended
for final ROM-programmable code.

HardwareDebug
This Build Mode has all optimisation turned off, and provides full debug information. This is the best
configuration to use whilst developing code as C code execution will be linear.

e Click the top level ‘Tutorial’ folder again, and , — . .
then the arrow next to the build button s miw il v % O 0D R
(hammer icon) and select the @ >

! ;o 1 HardwareDebug (Debug on hardware)
HardwareDebug’ option.

2 Release (Release - Mo Debug)

e e2 studio will then build the code.

R20UT5030EG0100 Rev.1.00 RENESAS Page 12 of 23
Jan.17.2022




Renesas Starter Kit for RX140

3. Tutorial Project Workspace

3.4.2 Debug Configuration

o Click the arrow next to the debug button (bug
icon), as highlighted by the red circle.
Select ‘Debug Configurations’.

O

Debug As »

Debug Configurations...
Organize Favorites...

o The ‘Debug Configurations’ dialog box will
appear. Click the small arrow next to the
‘Renesas GDB Hardware Debugging’ option.

e The debug configurations for each project will
appear. Select the entry for the ‘Tutorial
HardwareDebug'.

Q Debug Cenfigurations

Create, manage, and run configurations

R 57 v
type filter text

| Renesas GDB Hardware Debugging
[E9 Application HardwareDebug
| Application Release

"1 F

Async_Serial HardwareDebug
Async_Serial Release

| Low_Power_Mode HardwareDebug
Low_Power_Mode Release

| RTC HardwareDebug

] RTC Release
System_BootLoader_Application HardwareDebug

| System_BootLoader_Application Release
System_BootLoader HardwareDebug

| System_BootLoader Release

| System_Input_Capture HardwareDebug
System_Input_Capture Release

| Timer_PWM HardwareDebug
Timer_PWM Release

| Touch HardwareDebug
Touch Release

| Tutorial HardwareDebug

MEFEAAAFF AR

=1

Tutorial Release

Configure lau
- Press the

~ || ¥ - Pressthe

© - Press the
- Press the
X - Press the
- Press the
-Editorv
L - Selectla
u - Select la

r - Selectla

Configure lau

e The debug configurations control page will
then show for the Tutorial project. Change
the main tab to ‘Debugger’ and then select
‘Connection Settings’ on the secondary tab
bar that appears.

o There is no need to change the debugger
settings as they are preconfigured with the
Tutorial project. Please check “Power Target
From The Emulator (MAX 200mA)” is “Yes”.

o Refer to the RSKRX140 User’s Manual for
details of power supply configuration.

Note: e? studio will display a warning
if you attempt to connect with an
incorrect power supply setting.

o Click the ‘Debug’ button to continue.

e? studio will be connected to the debugger
and download the code to the target.

8 Debug Configurations

Create, manage, and run configurations

XBY~ Name: [Tutorial HardwareDebug

ppe e et Main [EHBBBIRNR > Startup| - Source| ) Common

# Launch Group o
T, Remote Java Applicatic Debug hardware: |2 Lite (RX) v| Target Device: |R5F51406

v [E] Renesas GDB Hardware

E

Application Hardwa GDB Settings Connection Settings Debug Tool Settings

[ Application Release v Clock
[ Async_Serial Hardwz Main Clock Source
1 Async_Serial Release Extal Frequency[MHz]

I3

Low_Power Mode H Operating Frequency [MHz]

EXTAL
8.0000
48,000

Low_Power_Mode R Permit Clock Source Change On Writing Internal Flash Memory Yes
[ RTC HardwareDebix ~ Connection with Target Board

7 RTC Release Emulator

{9 System_BootLoader. Connection Type
9 System_BootLoader. JTag Clock Frequency[MHz]

E

System_BootlLoader Fine Baud Rate[Mbps]

[ System_BootLoader Hot Plug

w

System_Input_Captu v Power

9 System _Input_Captu Power Target From The Emulator (MAX 200mA)

9 Timer_PWM Hardwa Supply Voltage (V)

E

Timer_PWM Release “ CPU Operating Mode

€9 Touch HardwareDeb. Register Setting

3

Touch Release Mode pin

[ Tutorial HardwareDe Change startup bank

Tutorial Release Startup bank

[ Renesas Simulator Deb

<

>

Filter matched 31 of 33 items

@

{Auto)

150

Close
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Renesas Starter Kit for RX140

3. Tutorial Project Workspace

e Afirewall warning may be displayed for ‘e2-
server-gdb.exe’. Check the ‘Private
networks, such as my home or work network’
box and click ‘Allow access’.

e Auser account control dialog may be
displayed. Enter the administrator password
and click ‘Yes'.

™ Windows Security Alert

O Windows Firewall has blocked some features of this app

Windows Firewall has blocked some features of E2 Server GDB on all public, private and domain
networks.
@ Name:
Publisher: Renesas Electronics Europe Lid
Path: C:\renesas'\e?_studio\debugcompyx'e2- server-gdb.exe

Allow E2 Server GDB to communicate on these networks:
Domain networks, such as a workplace network

[Private networks, such as my home or work network

[[Public netwarks, such as those in airports and coffee shops (not recommended
because these networks often have lite or no security)

What are the risks of allowing an app through a firewall?

!;éllow access Cancel

e After downloading the code a dialog box will
appear asking if you would like to switch to
the ‘Debug perspective’. Click ‘Remember
my decision’ to prevent this dialog box from
appearing in future, then click ‘Yes’.

e 2 studio will load the new perspective, which
is optimised for debugging.

Q Confirm Perspective Switch X

9 This kind of launch is configured to open the Debug perspective when it suspends.

This Debug perspective supports application debugging by providing views for displaying
the debug stack, vanables and breakpoints.

Switch to this perspective?

[] Remember my decision

=
e To change back to the default ‘C/C++’ {8 Open Perspective O %
perspective, from the menu bar select
Window > _Perspective >Open Pe_rspective > M C/Co+ (default)
Other or click the Open Perspective button. I Code Generator
% Debug
@ &' Java
e The ‘Open Perspective’ dialog box will ¥ Java Browsing
appear. Click on the desired perspective to %' Java Type Hierarchy
select it then ‘OK’. {4 Resource
e Perspectives can also be switched with the = Scripting
following shortcuts. a* Smart Configuraor
&"Team Synchromizing
Bg C/C++ %5 Debug
e The perspective should be 'Debug’, as it will
be needed in the next section.
Cancel

3.5 Running the Tutorial

e Refer to the description.txt file in the doc folder of Tutorial project for instructions on how to configure the

RSK and run the sample code.

e Once the code has been downloaded, click ‘Resume’ button “* to run the code to the main function. The
main function is set as the program entry point by default. The program counter will stop on the first

instruction in the main function.

e Click the ‘Resume’ button ™

in the ‘Debug’ perspective to run the rest of the code.

e Itis recommended that you run the entire tutorial demo first, before continuing to debug it.

R20UT5030EG0100 Rev.1.00
Jan.17.2022
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Renesas Starter Kit for RX140

4. Reviewing the Tutorial Program

4. Reviewing the Tutorial Program

This section will look at each section of the tutorial code and basic debugging functionality in e? studio.

41 Program Initialization

Before the main program can run, the microcontroller must be configured. The following parts of the tutorial
program are used exclusively for initializing the RSK device so that the main function can execute correcily.
The initialization code is run every time the device is reset via the reset switch or from a power cycle.

e Build and download the code as shown in
Section 3.4.

e On the Project Explorer tab expand the
‘Tutorial’ folder by clicking on the arrow
next to the folder icon, as highlighted by
the red circle.

=% Application
5 Async_Serial

=5 Low_Power_Mode

5 RTC

=5 Systermn_Bootloader

i% System_BootLoader_Application
5 System_Input_Capture

=5 Timer_PWM

= Touch

* Tutorial [Release]

= P

(.

e Click the arrow next to the ‘src’ folder to
show the source files.

¢ Expand the folder path 'smc_gen' ->
'r_bsp'->'board' -> 'generic_RX140' as
shown and doubile click on the file
'hwsetup.c'.

v 1% Tutorial [Release
& Binaries
sl Includes
v (B ac
v = smc_gen
&% Config_CMTO
& Config_CMT1
& Config_lCU
= Config_PORT
& Config_S124D0
& Config_SCI
= Config_SCl6
& Config_TMRO
& general
« = r_bsp
v = board
v = genenc_r140
= hwsetup.c
t wsetup.h

e Breakpoints can be set by double clicking
at the left-hand edge of the source
window. On the line with instruction

= static void peripheral_modules_enable(void)

{
/* Add code here to enable
- #if BSP_CFG_CONFIGURATOR_SELECT == 1

/* Smart ( gurator initialization function *

peripherals used by the

application */

‘R_Systeminit();’, double click next to the T ——
. . . } /* End of function peripheral_modules_enable() */
vertical line to set a breakpoint.
R20UT5030EG0100 Rev.1.00 RENESANS Page 15 of 23
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Renesas Starter Kit for RX140

4. Reviewing the Tutorial Program

Click the ‘Resume’ button in the Debug
perspective (or press [F8]) to run the code
up to this breakpoint.

1l

Note: The program counter is indicated by the
blue arrow next to the breakpoint.

ffed.

lees

= static void peripheral modules_enakle(void)

/* Adc code here to enable peripherals used by the application */
= #if BSP_CFG_CONFIGURATOR_SELECT == 1
/* Smert Configurator initialization function */

R_Systeminit();
#endif

} /% End of function peripheral_mocules_enable() */

Click the ‘Step Into’ button (or press [F5]),
to step into the ‘R_Systeminit’ function.

=L

The ‘R_Systeminit’ function calls several
initialization functions which configure the
MCU for normal operation. This includes
input/output ports, and system clocks.

The user can step through all the
initialization code by clicking the ‘Step
Into’ icon and reading the code however
for the purpose of this manual, it will be
skipped.

Click the ‘Resume’ button, to run the code
up to the main function.

0

-Woid R_Systeminit(void)
{

* Enabile ik
SYSTEM

Enable writing to MP(
MPC.PWPR.BIT.BOWI = oU;
MPC.PWPR.BIT.PFSWE = 1U;

* Write @ to the target bits i

POE.POECR2.BYTE = 8x00U;

* Initialize clocks settings *

R_CGC_Create();

* Set peripheral settings *

R_Config_PORT_Create();
R_Config_CMT@_Create();
R_Config CMT1_Create();
R_Config_ICU Create();
R_Config SCI1_Create();
R_Config_SCI6_Create();
R_Config S12AD® Create();
R_Config_TMRO_Create();

.PRCR.HORD = @xASOFU

For further details regarding hardware configuration, please refer to ‘Renesas Starter Kit RX140 User’s

Manual’ and ‘RX140 Group User’s Manual: Hardware’.

R20UT5030EG0100 Rev.1.00
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Renesas Starter Kit for RX140 4. Reviewing the Tutorial Program

4.2 Main Functions

This section will look at the program code called from within the main function, and how it works. It is
necessary to connect the G1CUSBO port on the RSK to a PC USB port and open a terminal emulation
program, such as Tera Term, with the settings:

Baud Rate: 19200,

Data Length: 8, Parity Bit: None, Stop Bit: 1, Flow Control: None
For information on installation of the RSK virtual COM port driver, refer to the file ‘description.txt’ in the doc
folder of the e? studio Tutorial project.

e Select and right click the ; Vot sl Ll
‘R_Config_SCI1_Serial_Receive’ function B i e
call and select ‘Run to Line’ to execute the { -
program up to this line. The ‘R_LCD_lInit’ B o oo ERESITORERREE
function call enables and configures the e
LCD panel, and ‘R_LCD_Display’ will FF5c09: R_SWITCH_SetPressCallback(cb_switch_press);
write “RSKRX140 Tutorial Press Any O
Switch” onto the LCD. 100 £££c08 R_LCD_Init();
R_LI(D“_;)';.S;I;!}‘(B, :.(.ui;\.r.s;-_fl *)'-'.”R‘_sl.(RXM.H");
R;ll(D._IT);séle;y(‘l,...(uin:-.r;-_'rl ')'-' T;n.'nrinl o I
R;LIED._IT)i.Séle:!y(E, ..(.IJ']I.".TTIR-_T!;');..PI"ESS Any Switch *};
R_Confie S12A00. Start();
y ?I’?et goz"f?;kgg'ﬂt OSr}[e;Tt’efunc fion call by B 10 frfcoosn | R_Config SCI Senisl. Receive((uintd ¢ *)ag rx.char, 1);
double-clicking in the breakpoint column. 1o EET e o
e Click the ‘Step Into’ button to step into the '
‘R_Config_SCI1_Serial_Receive’ function.
-
° The program counter should now move W62 1 E[);.rmus R_Config SCI1 Serial Receive(uint8 t * const rx_buf, uintlé_t rx_num)
into the ‘R_Config_SCI1_Serial_Receive’ | i B
function definition. This function is an API ¢ )
function provided by the Smart ! g i R
Configurator. It sets up the SCI interrupt ' lee
handler code to receive a specified o o ins g SO
number of bytes into a receive buffer. 5 e e e
Once the specified number of bytes has s )
been received, the interrupt handler code rorgl |y sy
calls a callback function as shown lateron |
in this section.
e For full details on how to configure a
project using Smart Configurator refer to
the Smart Configurator Tutorial Manual.
o Click the ‘Resume’ button to resume
program execution.
1]
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Renesas Starter Kit for RX140 4. Reviewing the Tutorial Program

and callback functic

/* Set up SCI1 receive b

° The program Counter ShOU|d come to a halt R_(Dm‘ig_‘;(Il_serial_;E;;i;;i({;intH_t *)&g_rx_cha;: 1),

at the ‘R_Config_SCI1_Start’ function.

11 /* Enable SCI1 operations */
e Step over the function by clicking the ‘Step 10 GEREE | R_Config SCI1 Start();
Over’ button. Alternatively, press [F6].
=
The ‘R_Config_SCI1_Start’ function enables
the UART interrupts. The program then
proceeds to the main while(1U) loop. The code
inside the loop waits for user input from either
the SCI or RSK switches, and then performs
an A/D conversion.
e Locate the function call to ‘lcd_display_adc’ i g I;'h:ile (1)
inside the while loop. 12 wint16_t adc_result;
e Set a breakpoint on the ‘lcd_display_adc’ _ /* Wait for user requested A/D conversion flag
function call by double-clicking in the break | ... = g‘adc_‘t"gg“) |
point column. adc'_:éluit: ey
a ) FFfcB976 lcd_d15|]:|].;yiadc(adlc_r_‘es‘ul|_:), :
e Inthe Project Explorer pane, locate the file v & Tutorial [HardwareDebug]
‘Config_SCI1_user.c’ and double-click to & Binaries
open the source file. Scroll down to the
. nil Includes
function o
‘r_Config_SCI1_callback_receiveend’. o
w = smC_gen
& Config_CMTO
& Config_CMT1
& Config_ICU

& Config_PORT
= Config_S512AD0
~ k= Config_SCI1

ie| Config_SCI1_userc
tgl Config_SCl.c
{n Config_SCI1h

i Config_SClI6

& Config_TMRO

&= general

o Seta breakpoint on the line of code inside T | I ——
the ‘r_Config_SCI1_callback_receiveend’ /* Start user code for r_Config SCI1_callback_receiveend. Do |
function as shown opposite. Bond daiiimbe st pmeaunll o
210 fffclae2 i ‘c' == g_rx_char 'C" == g_rx_char
e Continue to execute the program by clicking | ' !’ S e
the ‘Resume’ button. 2 }

/* Set up SCI1 receive buffer and callback function aga
R_Config_SCI1_Serial Receive((uint8_t *)&g_rx_char, 1);

11ba in */

R20UT5030EG0100 Rev.1.00 :{ENESAS Page 18 of 23
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Renesas Starter Kit for RX140 4. Reviewing the Tutorial Program

¢ In the terminal emulation window, press the 219. Fitclaelags ?f (('c” = grichar) || (°C° = @ rx_cher))

‘c’ button on the keyboard. o1 g adc_trigger = TRUE;

e The program will halt at the breakpoint in !

the ‘r_Config_SCI1_callback_receiveend’
function as shown opposite. Remove the
breakpoint by double-clicking on the
breakpoint column.

e Continue to execute the program by clicking
the ‘Resume’ button.

=

e The program will halt at the breakpoint in N ETEE AR B

the main while loop.

e Remove the breakpoint by double-clicking 135 fie ey Wit s
on the breakpoint column. Continue to e { . .
execute the program by clicking the : ' . T mm e

‘Resume’ button. 139 fffceg9 led_display_count(s_adc_count);

L=

The program proceeds to display the result of the A/D conversion on the LCD and in the terminal window. In
addition, the running count of A/D conversions performed is displayed in binary form using LEDs 0-3 on the
RSK. Adjust the potentiometer and press SW1, SW2 or SW3 on the RSK and an additional A/D conversion
will be performed.

e Press the ‘Suspend’ button to halt program

execution. LiLd
e To change back to the default ‘C/C++’ Window  Help
perspective, from the menu bar select New Window TR A0 YL IR = R Wi b
Window > Perspective >Open Perspective A ’
> ‘C/C++'. Shuseans "L Gconfigscre [T : config 12400
Show View T ,S id Contig_ L ontig_! .
Perspective > [£/ Open Perspective > L C/C++
Navigation > Customize Perspective.. j‘: s
¥ Java Browsing
Save Perspective As..
Preferences k
: Reset Perspective... Other... (
R_Con e pmp_toA_wawey 1)
Setup Views For Device >
E=Ef) Close Perspective
ffc@96a R_Con Close All Perspectives
e Alternatively, click on the ‘C/C++’ button in -
the top right corner of the screen, as shown g C/C++ | 4+ Debug

opposite.

e This is the extent of the tutorial code.

For further details regarding hardware configuration, please refer to ‘Renesas Starter Kit for RX140 User's Manual’ and
‘RX140 Group User’s Manual: Hardware’.

The E2 emulator Lite features an advanced logic-based event point trigger system, and full instruction on its use is outside
the scope of this tutorial. For further details, please refer to the E2 Emulator Lite User’'s Manual.
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5. Additional Information

Technical Support

For details on how to use e? studio, refer to

the help file by opening e2 StUdiO, then Window Help

selecting Help > Help Contents from the | ©'~ ¥ Veisome |
menu bar. (7} Help Contents
Search

Show Context Help |

Parts of the sample code provided with the RSKRX140 can be reproduced using the Smart Configurator tool.
Smart Configurator is included as a plug in with e? studio.

Source files and functions generated by Smart Configurator are prefixed with r ' and ‘R_’ or ‘Config_’,
respectively.

Technical Support
For information about the RX140 Group microcontrollers refer to ‘RX140 Group User’s Manual: Hardware’.

For information about the RX assembly language, refer to ‘RX Family User’s Manual: Software’.

Technical Contact Details
America: techsupport.america@renesas.com

Europe: https://www.renesas.com/eu/en/support/contact.html
Global & Japan: https://www.renesas.com/support/contact.html

General information on this product can be found on the Renesas website at:
https://www.renesas.com/rskrx140

General information on Renesas Microcontrollers can be found on the Renesas website at:
https://www.renesas.com/

Trademarks
All brand or product names used in this manual are trademarks or registered trademarks of their respective
companies or organisations.

Copyright

This document may be, wholly or partially, subject to change without notice. All rights reserved. Duplication of
this document, either in whole or part is prohibited without the written permission of Renesas Electronics
Europe GmbH.

© 2022 Renesas Electronics Europe GmbH. All rights reserved.
© 2022 Renesas Electronics Corporation. All rights reserved.
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